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An overview of Connection Manager
Connection Manager is a graphical client connection manager that is part of the Navigator Graphic User Interface for Wildcat! 5
This program allows callers to view the remote system    in a different way, a visual representation of a BBS that has the look of 
Windows 95. The Navigator interface creates a user interface for Wildcat! BBSs that is easy to use and flexible. 



Automatic upgrading
When you connect to a remote system, the connection client checks the host system for Navigator version information. If you are 
using an older version than the one used by the Host, you will be prompted to download either a "patch" upgrade, if the version is 
not much older, or the entire new Navigator, if the version is more than one version previous. 
This is all handled automatically by the connection client. Once you have received the latest version, it will be properly installed for 
you, and opened as you move around in your current connection.



The Command Menu
The command menu lets you select options from a drop-down menu. All of the options available for the connection manager are 
available through these menus. The different command menus are:
Connections
Dial
View 
Help



Connections
The Connections menu lets you create and edit your connection list. These are the remote systems that you want to connect to. 
Use New to create a New connection, Insert to insert a connection at the currently marked entry point, Delete to delete a 
connection, etc. These are the options available from the Connections menu:
New
Insert
Delete
Properties
Devices
Dial Properties
Exit



New 
Opens a new connection manager file.



Exit
Closes the Connection Manager.



New
Creates a new connection entry at the cursor position.



Insert
Creates a new connection entry and places it at the bottom of the current entry list.



Delete
Deletes a highlighted entry.



Properties
Opens the Connection Properties dialog box, allowing you to add and edit new connections.



Devices
Opens the Device List dialog box, allowing you to add and edit new devices.



Dial Properties
Opens a general dialing properties sheet. Enter the information about accessing outside lines, area codes, and credit card numbers,
if required.



Dial
Dials the selected entry or makes the proper FTP/Telnet connection.



View
The View menu lets you determine how the connection manager appears on your screen. Use View Toolbar/View Statusbar to 
toggle the toolbar and statusbar view on and off, and select from the other options to select the way that your screen displays 
connection information. These are the options available from the View menu:
Toolbar
Statusbar
Large Icons
List
Details



View Toolbar
Toggles the toolbar view on and off.



View Statusbar
Toggles the statusbar view on and off.



View Large Icons
Displays screen information as large icons, with only the name available.



View List
Displays screen information in a list format, with minimal details about each item.



View Details
Displays screen information in a list format, with information details about each item.



Help
The Help menu launches the online help engine. You can get help about specific items or general topics. These are the options 
available from the Help menu:
Help topics
About



Help topics
Launches the online help system.



About
Displays version and other information about Navigator.



The Connection Screen
The main screen information bar displays information about connection entries.
System Name
Phone/Address
Device



System Name
This is the name of the host system to connect to.



Phone
This is the phone number, telnet, or IP address used to make the connection.



Device
This is the device used to make the connection.



Connection Status Box
Shows the current status of your connection



Details
Clicking details displays information about the current connection, including the number of bytes sent and received.



Disconnect
Click the Disconnect button to cancel the current connection.



Cancel
Closes Connectin Manager without connecting.



New Connection
Select Connections/New to add a connection to the connection client list. An Edit Connectiondialog box appears.



Edit Properties
Opens Connection Properties dialog box, allowing you to add, edit, and change the device for connection destinations.



Edit Connection Properties 
The  Connection Properties property sheet allows you to add, edit, and delete connection and device settings. When you are 
satisfied that the information is correct, select OK to save and accept any changes you have made. Choose Cancel to close the 
dialog box without saving changes.
System
Area code
Phone/Host
User ID
Password
Device to use
Device List OK 
Check for new mail at login
Cancel



Default Location
There is no method to set a default connection site. You must select the service you wish to connect to each time you connect.



Area code
Enter the area code of the system you are connecting to.



Check for new mail at login
Automatically checks at connection for new personal mail. You are notified if you have received new mail since your last connection 
to this BBS.



Connection List
Displays a list of all connections entered into the connection client database. Click on an entry to highlight it, or double-click to open 
the Edit Connection dialog box for that entry.



New
Creates a new connection and opens the Edit Connection dialog box.



Delete
Press the Delete key or choose Connections/Delete to remove the highlighted entry from the list of available connections.



Edit Connection 
Opens the Edit Connection Dialog Box and loads in the highlighted entry information.



OK
Confirm your selections and close the current window.



Cancel
Closes the Connection List dialog box without saving changes.



System
Type in the name of the system. This is how it will appear on the Connections list in the initial Navigator screen.



Phone/Host
Type in the phone number or telnet address of the remote system. This is the number that will always be used when the request for 
this connection entry is made.



User ID
Type in your User ID. (This is the name you use to log on to the remote system.)



Password
Type in the password you use when logging on to this system. The remote system makes use of MD5, RSA Data Security's 
password encryption system.



MD5 Encryption Security
MD5, RSA Data Security's encryption algorithm, is used to make sending passwords over the Internet more secure. What is does is 
essentially scrambles your password as you send it. Each end of the connection encrypts the password, and then when you send 
the password over the wire, the host compares what is sent to its own encryption. Your password itself is never actually sent over 
the wires. Connection Manager and the remote system both support MD5.
The technical description of MD5 is that "the MD5 message-digest algorithm takes as input a message of arbitrary length and 
produces as output a 128-bit "fingerprint" or "message digest" of the input.



Device to Use
Select the device to use for the connection by clicking the down arrow in the drop-down box. A list of devices that have already been
entered will drop down. You can choose one of the existing device entries, or you can enter a new one by selecting New Device.



OK
Confirm your selections and close the current window.



Cancel
Closes the dialog box without saving changes.



The Device List dialog box
To add a new device for connection client to use when connecting, select Edit/Devices and click on New. A Device list entry will 
appear in the listbox. Highlight the new entry and click Edit. 
The Serial Device Properties sheet appears, allowing you to choose the settings for the new device.
Device Listbox
New
Edit
Delete
Device List OK 
Cancel



New
Adds a new device to the Device List window. This can then be edited by using the Edit button.



Edit
When the Edit button is activated, a Serial Device Properties sheet appears, allowing you to select configuration options for the 
device.
A No configuration Needed message will appear if a telnet or winsock connection is selected.



Delete Device
Deletes the highlighted device. You will not be prompted to confirm before the deletion is applied.



Serial Device Properties Overview
The Serial Device Properties property sheet allows you to set options for a serial device. 
Port 
MaximumSpeed
Lock port at this speed
Cancel call if not connected by 
Disconnect call if idle 
Reset string
Dial string



Serial Device Properties General
Port    
Maximum speed 
Lock port at this speed



Port
Select the port you want the device to use from the drop down box that appears when you click the down arrow to the right of the 
display box.



Maximum Speed
The baud rate is the speed at which the COM port operates and should in most cases match the top speed of the modem, or the 
locked DTE speed for high speed modems. High speed modems, that is, modems with nominal baud rates of 9600, 14400, 16800 
and higher, should always be set to a higher baud rate than the actual connect speed, to enable hardware flow control, data 
compression and error correction. Thus, the correct setting for a 9600 or 14,400 baud modem would be 38400 or 57600.



Lock port at this speed
Some modems will match the speed of the host system automatically, but you may want to force a speed for your modem. Enable 
Only Connect At if you want the device selected to connect only at the selected speed.



Connection Overview
Cancel call if not connected within __ seconds 
Disconnect call if idle more than __ seconds 
Reset string
Dial string



Reset string
Default: ATZ      Enter the command to reset your modem.



Dial string
Default: ATDT Enter the command to tell your modem to dial. 



Cancel Call If Not
Select this if you want the device to cancel a call (stop attempting to make a connection) after a specified period of time. Type the 
number of seconds the device should wait before canceling a call into the text box next to "seconds". When Cancel Call if Not... is 
enabled, a checkmark appears in the box beside it.



Disconnect If Idle
Select this if you want the device to disconnect a call after a specified period of idle time (no activity of any kind). Type the number of
seconds the device should sit idle before disconnecting a call into the text box next to "seconds". When Disconnect If Idle is 
enabled, a checkmark appears in the box beside it.



OK
Confirm your selections and close the current window.



Cancel
Discard your selections and close the current window.



Apply
Applies your selections without closing the property sheet.



Help
Opens the help file (this file).



OK
Confirm your selections and close the current window.



Cancel
Discard your selections and close the current window.



Apply
Applies your selections without closing the property sheet.



How do I...
Getting started
Add a BBS to my list? 
Change the settings for my modem? 
Connect to the BBS
Logging on locally
Getting around in your favorite BBS
Dialing a connection
Changing connection settings
Editing an entry
Configuring an entry
Launch other clients



Add a BBS to my list?
To add a new entry to your list: 
1.      Select Connections/New from the command menu, or press [INS]. An Edit Connection dialog box appears.
2.      Enter the information in the Edit Connection dialog box that appears - System, Area code, Phone/Host, User ID, Password, and

Device to Use. 
3.      Once you are satisfied with your selection, choose OK.
If the device to use is not in the list that drops down:
1.      Cancel the New Connection and select Connections/Devices. 
2.      Click on New. 
3.      Highlight the New Device that appears, and then click Edit. 
4.      The Serial Device Properties sheet opens. Enter all the information and select your preferences. 
5.      When you are satisfied with your selections, press OK to accept. 
6.      Return to Connections/Properties. When you highlight the entry and click Edit, your previous information has not been 

changed, and you can select your new device. 
7.      When you are satisfied with all your selections, press OK. 
Your new entry will now appear in the textbox, and you can select Dial to begin connecting. You must enter a dialing entry, or 
connection, for each service you want to connect to using the Navigator.



Change the settings for my modem?
To select different settings for your device (modem):
1.      Select Connections/Devices from the command menu. 
2.      Highlight the entry that you want to edit, and click Edit. 
3.      The Serial Device Properties property sheet opens, allowing you to change any of the settings for that entry. 
4.      When you are satisfied with your selection, click OK.



Getting Started
The Navigator programs and support files are placed into their own directory. Start the connection manager (WILDCAT.EXE). 
You can connect via regular modem/phone connection, PPP, FTP,    or telnet. Connection Manager has been designed to be easy to 
use. The dialer program maintains a dialing directory, and is responsible for establishing and maintaining communication with the 
remote system.
The first thing you must do is configure a dialing entry for your own or another system.



To configure a dialing entry
You must initially configure a dialing entry for each connection you make using the Navigator. These are stored by Connection 
Manager and will not need to be configured again, unless changes are made to the host connection. To enter a dialing entry:
1.      Start Connection Manager, and select Connections/New. A New Connection screen pops up. 
2.      Enter the information on the Connection property sheet that appears - System, Phone/Host, User ID, Password, and Device to 

Use. 
3.      When you are satisfied that all the information you have entered is correct, click OK.
Most likely, the device you want to use will be listed, but if the device to use is not in the list that drops down:
1.      Save your new connection by clicking OK.
2.      Select Connections/Device.
3.      Click on New. The Serial Device Properties sheet opens. Enter all the information and select your preferences. 
4.      When you are satisfied with your selections, press OK to accept. 
5.      Highlight your new connection entry and select Connections/Edit or click the Properties icon.
6.      You can now select your new device to be used with your new connection entry. 
7.      When you are satisfied with all your selections, press OK. 
8.      Your new entry will now appear in the textbox, and you can select Dial to begin connecting. 



To edit an entry
If the BBS you are calling changes its phone number, connection speed, or anything that requires you to change your configuration, 
you will need to edit your dialing entry. 
1.      To change the name, phone number or IP address, your user information, or the device to use:
2.      Mark the entry and select Connections/Properties. 
3.      The Connection Properties dialog box opens, allowing you to change any of the settings for that entry. 
4.      When you are satisfied with your selection, click OK.
To change the device settings, select Connections/Device from the command menu.



To change your connection settings
Sometimes, you may want to change the settings for the modem used to connect to a particular entry. While TAPI handles the 
addition of new modems, you may need to set a speed or port, or other setting unique to the system you are calling. Here are the 
steps you must take to edit your connection settings.
1.      Select Connections, then Devices. 
2.      Highlight the entry to be changed , and click Edit. 
3.      The Serial Device Properties property sheet opens, allowing you to change any of the settings for that entry. You can select the 

port, speed, data bits, parity, stop bits, speaker volume, set dialing options, and terminal window opening times by using this 
property sheet.

4.      When you are satisfied with your selection, click OK.



To dial your connection
Double click on the entry to which you want to connect, or click once and then click Dial. 
Connection Manager will dial the entry. 



Getting Around in Your Favorite BBS
Since each sysop sets up a BBS differently, it is impossible to describe all of the variations that can be used to move around in a 
given BBS. But no matter how your sysop has set up the BBS Web page, you should find it easy to get around. 
When you find the link to the section you want to view, click on the link and the appropriate Navigator Client program is launched. 
For instance, if you click on the "Files " section of the BBS, the file client is automatically started, so that the files and folders are 
displayed. You can also use the link    icons at the top of the Connection Manager screen.



Logging on locally
To log on locally, you must set up a local host entry in the Conection list. Each address you use must be unique. You do not need to 
worry about configuring anything for DNS, Default Gateway, or any other setting. 
With a TCP/IP network
Without a TCP/IP network



Without a TCP/IP network 
1.      Set the dial string in Connection Manager to your IP address or use the dial string "localhost ". 
2.      Enter your system name, User ID and password, device to use.
3.      Click OK.
Double click on the entry, or mark the entry and select Dial from the command menu.



With a TCP/IP Network
1.      Go to Windows Control Panel and select Network.
2.      Change the default IP Address . This is actually the local machine address in all cases. You can use 10.0.0.1 (this is an 

address reserved for a system that is not connected to the global Internet).
3.      Set the dial string in Connection Manager as either the same IP address as above, or the dial string "localhost ".
4.      Click OK.



Connect to the BBS
Double click on the entry to which you want to connect. If the local sysop has provided the BBS with a web connection, you will see 
a home page guiding you through the different sections of the BBS. 



Command reference
Connections menu commands
Dial menu commands
View menu commands
Help menu commands



Connections
New - Opens the New Connection property sheet. Lets you create a new dialing entry.
Insert - Insert a new entry at the current location.
Delete - Deletes marked entry.
Properties - Opens the Connection Properties property sheet.
Devices - Opens the Edit connect devices property sheet.
Dial properties - Lets you edit properties used when dialing out from your modem.
Exit - Closes the connection manager and disconnects any current connections.



Properties
System - The name of the system to connect to.
Area code - Type the area code for the system you are connecting to.
Phone/Host - The phone number or telnet address to be used for this connection.
User ID - Type in your user ID for this connection.
Password - The password used when making this connection. Your password for this connection.
Device to use - The device to use for this connection.

Device Name - The name (if a modem) or properties (if a telnet connection) of this device.
Port - The port to be used for this device.
Maximum Speed - Sets the maximum speed allowed for this device.
Lock port at this speed - Forces the connection to be locked at the set maximum speed.
Cancel call if not connected within - Sets the length of time to pass before the attempt at connection is canceled.
Disconnect a call if idle for more than - Sets the length of time that the connection is idle before disconnecting.
Reset string defines the string sent when you want to reset your modem. Refer to your modem amnual for more information.
Dial string defines the string sent when you want to tell your modem to dial. Refer to your modem amnual for more information.

Check for new mail at login
Checks for personal mail received since your last connection to this BBS.
OK - When you are satisfied with your selections, click OK. 
Cancel - Closes the device list dialog box without saving your selections.
New - Opens the New device property sheet, allowing you to set up a new device for use when connecting.



Dial
Dials the currently marked entry.



View
Toolbar - Toggle the toolbar view on and off.
Statusbar - Toggles the statusbar view on and off.

Large icons - Displays entries as large icons. Only the name and large icon associated with the entry is 
displayed.

List - Displays entries as small icons. Only the name and small icon associated with the entry is displayed.
Details - Displays the entry as a small icon with associated details      System name, phone or address, and associated device.



Help
Help Topics - Launches the online help system.
About - Displays version and resource information about the Connection Manager.



DLL Errors
If you receive a "Call to Invalid Dynalink" error when using the Navigator, you may have an older version of CTL3DV2.DLL on your 
system, and Navigator was not able to install over it because it was in use when Navigator was installed. 
Delete any copies of CTL3DV2.DLL from your computer and reinstall the Navigator.



Troubleshooting
I've received an Invalid Dynalink (CTL3DV2.DLL) Error
Using Windows 3.1, I keep getting a cache error



CACHE Error
If you get a cache error (Error 262) when the Navigator starts up, you need to load SHARE.EXE before running Windows. Add the 
following line to your AUTOEXEC.BAT file:
SHARE.EXE /L:500 /F:5100



Launching other clients
Once you are connected to a remote system, you can launch other clients directly from the connection manager by clicking the 
appropriate icon displayed at the top of the screen.



How do I connect to remote systems using my access provider?
If you are using an access provider or ISP (Internet Service Provider) to connect via the Internet, and want to connect to a renite 
system using the Navigator, you may be able to do this several ways, depending on your provider.
Check with your access provider. The access connection package provided by your provider may have additional options.    If you 
perform all of your telnet options from a menu on your provider's account, you may have a different kind of account. This account 
actually runs on the ISP system and just sends info back to you.    In this case you may not be able to run Navigator using your 
access provider. If you are unsure about the type of account you have, check with your access provider. The question to ask is    
"Can I run my own Telnet Client on my PC?"
To connect using an ISP:
1.      Create an entry for the BBS you are connecting to, select Telnet as the device to use. Enter the telnet address for the BBS.
2.      Connect to your access provider in your usual way.
3.      Once the connection is made, launch the Connection Manager and connect to the BBS entry.



Bring up terminal client on connect
Check this box if you want Connection Manager to open a terminal window when it connects with the dialing entry. 



User name
Enter your User ID. This is the name you use to log on to the remote system.



Password
Enter the password you use when logging on to this system. 



Remember my password
Check this box if you would like to save your password and send it automatically, rather than entering it each time you connect. 



Check for new mail at logon
Automatically checks at connection for new personal mail. You are notified if you have received new mail since your last connection 
to this BBS.



Connect
Click the Connect button to log onto the remote system.



OK 
Confirm your selections and close the current window.



Cancel
Closes the dialog box without saving changes.



Apply
Applies your selections without closing the property sheet.



Delete
Deletes the highlighted device from the list.



Help
Click the Help button or press F1 for help on any topic.



Settings
The Settings button pops up the Connection Settings property sheet, which allows you to view and edit your modem (device) 
settings.



Connection settings
The Connection Settings dialog box contains information on the network address and phone numbers of the remote system, as 
well as the device (modem) on your computer to use for the connection. 
There are two ways to connect to a remote system:

Connect using my local area network or another dial-up Internet provider 
Connect using Dial-up access 



Connect using my local area network or another dial-up Internet provider
This selection connects to the remote system using your local internet connection or a dial-up internet provider. 



Connect to
If the remote system has more than one IP (Internet Protocol) address, select the one you prefer to use for this connection.



Connect using Dial-up access
This selection connects to the remote system using your modem and telephone line.



Dial number
If the remote system has more than one access number, select the one you prefer to use for this connection. 



Connect using
This is a list of devices (modems) to use. Select the port where your modem is located.



Dialing properties
This button opens the Dial properties property sheet. 



Dial properties
This property sheet allows you to specify how local and long distance phone numbers should be dialed.
To access an outside line 
My current area code is 
To dial long distance 
Dial using credit card 



To access an outside line
If you are calling from a PBX (switchboard) phone system and must dial a number to place outgoing calls, enter that number here.



My current area code is
Enter your area code in this field. 



To dial long distance
If your local phone company requires you to enter a number (for instance 1) to place a long distance call, enter that number here.



Dial using credit card
If you wish to use a telephone credit card to place your call, enter the card number in this field. Connection manager will 
automatically send this number when dialing.



New
The New button allows you to create a new device (modem) to use for dial-up connections. 
Fill in the Serial Device Properties page with the new information.



Properties
The Properties button allows you to view or edit an existing device (modem) to use for dial-up connections. Fill in the Serial Device 
Properties page with the new information.



Serial device properties
The Serial Device Properties property sheet allows you to set options for a serial device. 
This property sheet has two tabs: General and Connection.



General
The General tab has the following options:
Device name 
Port 
Maximum speed 
Lock port at this speed



Device name
Enter the name of this device, for instance Modem on Com 2 or US Robotics Sportster. 



Port
Select the port you want the device to use from the drop down box that appears when you click the down arrow to the right of the 
display box.



Maximum speed
The baud rate is the speed at which the COM port operates and should in most cases match the top speed of the modem, or the 
locked DTE speed for high speed modems. High speed modems, that is, modems with nominal baud rates of 9600, 14400, 16800 
and higher, should always be set to a higher baud rate than the actual connect speed, to enable hardware flow control, data 
compression and error correction. Thus, the correct setting for a 9600 or 14,400 baud modem would be 38400 or 57600.



Lock port at this speed
High speed (9600 bps and faster) modems work best when the port speed is locked at a higher baud rate than the actual modem 
speed. For best performance with a high speed modem, turn this option on.



Connection
The Connection tab has the following options:
Cancel call if not connected  
Wait seconds before redial 
Reset string 
Dial string 



Cancel call if not connected 
Select this if you want the device to cancel a call (stop attempting to make a connection) after a specified period of time. Type the 
number of seconds the device should wait before canceling a call into the text box next to "seconds". When Cancel Call if Not... is 
enabled, a checkmark appears in the box beside it.



Wait seconds before redial
If the line is busy when you try to connect, Connection Manager will retry the connection automatically. Enter the number of seconds
Connection Manager should wait between calls in this field. 



Reset string
Enter your modems reset string in this field. Most modems use ATZ as the reset string.



Dial string
Enter your modems dial string in this field. Most modems use ATDT for tone dialing, or ATDP for pulse dialing.



The Custom Connector
Enter your User Name and Password in this screen, then click Connect to log onto the remote system.
If you need to view or update your modem settings, click the Settings button. 
To close the Custom Connector, click the Cancel button.




